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Annex 1 User’s Guide for Computer-Aided Planning

| INTRODUCTION

The PWASP Data Management Uscer’s Guide explains the procedure of encoding data and generating
tables and figures for the PWA4SP. The Guide consists of the following scctions. ‘

. Scction 2: hardware and software required to successfully run the PWA4SP Data
Management System '

’ Section 3: the concept of the micrecomputer archilecture and an overview of hardware
configurations

. Section 4: fundamentals to operate the system with internat architecture
. Scction 5: basic concept of software operation

. Section 6: a complete list of data files'and worksheets in the PW4SP Data Managcment
System

. Section 7: data linkages .
) Seclion 8: the procedure of updating the PW4SP

. Section 9: standard reporl format

2, SYSTEM REQUIREMENTS

The following are the basic reqixiremcnts to suceessfully run the PW4SP data management.

Hardware: Seftﬁ-'are:

Computer: Pcriljum Series Operating Systelﬁ: Window 95/98
RAM: 32 MB (minimum) Windows Package: ~ MS-Office 97
Hard Disk: 3 GB (minimum) Spreadsheet: - MS-Exce]I 97
Floppy Drive: 3.5 inch, High Density Word Processing: ~ MS-Word 97
Menitor: VGA Monitor f |
Printet: 80 coluri}n (Can handle A4 size paper). _

Mouse: Any brand tﬁat’ supported.by MS-Windows .

Miscellaneous: 500 watls Autornatic Volfage
Regulator and Surge Protector
UPS 450 watis



Ay
(e

3. MICROCOMPUTER SYSTEM

All computers, whether large or small, Lasically operate on the same fundamental principles. The
hardware and software of a mainframe computer and a microcomputer have the same componenis

and fulfill the basic functions necessary (o any computer system.

The computer is scen as a powerful tool that can cnable us to expand the horizons of our knowledge.
It allows processing of large volume of data or complex pattern of information that would otherwise

be difficuil to organize and understand. Morcover, it allows for an casy manipulation of data.

There are two major components of a microcomputer: the hardware and the sofiware. These two

components complement cachother in order to fulfill their basic function.

A microcomputer hardware is made up of scvcral componcnts based on the functions they perforn in

the system and how they interact with the other components.
The priﬁcipal elements of a computer system are:

Central Processing Unit (CPL)

Main Memory (RAM)

Sccondary Storage Devices (disk, drives, magnclic lapes, etc.)
lnput;’Outpul Devices (monilors printers, etc.)

a @ ¢

The CPU does the ac!ual compuimg It is capab!c of smlple arlihmctrc and loglcal operauons such as
addmon and data companson that are executed at exceedmgly hrgh speed. The powcr of a computer
directly stems from the speed and accuracy with which the CPU can carry ot computations and move

information around The main menory of lhe computer is usually referred to as Random Access

. Memory or RAM T hls part oflhc computer contains the programs and mformauon thal are currently

bemg processed by the CPU. Secomiary storage dewce such as magaetic dlsk is capable of holding
large amount of data. Programs and data are normally stored on these secondary dev:ees and could
be relneved when needed. They are then loaded into the RAM and execuled T hc results of the
processing can then be wrilten into lhelsecondary storage device or sent to an oulput device such as
the monitor or priniter. Peripheral devices or InpuUOtitput’(llO) devices allow the user to put data into
a e'onmputer or receive out]Sut from a computer. A terminal is 2 penpheral that conlains both &

keyboard for input and a monitor for output. Other perlpherals include prmters and plotters.



The dragram below preseats the basic hardware component of a microcomputer system,

Central Processing Unit 7

(CPU)
1/0 ‘Ferminal Secondary Storage
Random Access Memory
Keyboard (RAM)
|&p! Hard Disk
Monitor 1‘_ ‘
L] Floppy Drive
Printer <

Fioppy Drive isrt.he most common type secondary storage uséd in personal c_loniputer today. It acts as
an c'\c'léme.ll drive f‘rcm .wﬁiéh the users ilns.ert the ﬂoppy disk to étt:;rc and rétfiéxfc infbfﬁialion The
ﬂoppy disk comes in three su:cs 3. 5 mchcs 5.25 inches and 8 inches. 1l is characlenzed by thin |
cireular plaqtlc sheets coated w1th iron oxide so that magnetic pattems recorded on it can be rctamed
The surface is similar to a magnetic tape used to record music. The 5.25 inches diskette is conlamed
in a square cardboard envclopc in whlch it spins. The 3 5 inches dlskettc is contamed in & hard plashc )
case wnlh a metal shulter that protects the magnellc medla A ﬂoppy dlsk can store from 80 kilobytes
to 1.44 megabytes of dala. Floppy disk system is stower and has less storage capacily than hard disk

system, but its lower cost makes it a'po;')ular choice for personal computer users.

Hmd disk is made of magnellc metal, and can e;ther be removable or non-removable. The most
common type of hard disk that is found in personat computer today is non-removable. This disk |
typically holds from 10 megabytes to 3.2 gigabytes of information. Each megabyte is equivalent to
],{)48,57‘6‘charéctcrs of _in_fonnét_ion_, or roughly 1,800 single-spaced typewritten pages; hence, this is

a very efficient way to store large volume of information.

Keyboard is an external device that acts as a primary interface between the human operator and the
computer. The keyboard has 3 basic components: the typewriter keyboard which is composed of
alphabet characters; the calculator pad which is composed of numeric characters; and the function

keys which serve as special macro key for various software.
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Monitor is the screen or video display peripherat and scrves as the main output device on a personal
computer. ftis used to display text and graphices information and is available in a variety of sizes and
types. Monitors ean be divided into two broad greups: those designed to display text information; and
those designed to display graphics information, such as chatts or picture. Within the graphies group,
there are color or monochrome (single color) displays. A high quality graphic color monitor is

capable of showing high-resolution pattern and is recommended for application in MS-Window,
Excel, or AutoCAD.

Printer is another common peripheral found in personal computer system. The common types of
printcrs' are dot malrix, inkjet and taser printer. The dot matrix printer produces its image by printing
a Qmup of dots ‘lha_t form the image of a characler or symbol. The iﬁkjcl printer is similar to the
impact dot matrix p_rirﬁer, instead of using the pin impact force to create an image it use ink bubble to
create sinkilar image. The inkjet printer is much lighter and quict than the impact dot malrix printer.
Today, it is the popular choice due to it characteristic and wide availability of selection. The laser
printer produces its image by means of electrophotograph similar te the principle of photocopy
machine. The image produced in the laser printer is tmuch crispier than the inkjet printer due the high-

resolution capability. Both the inkjet and laser printer can produce color print.

4. OPERATING SYSTEM

Operatmg systems isa set of control program lhal managcs the computer’s resources and creates a
well-defi ned soflware ¢nvironment {or compulu applications. Computer hardware by itsclf can
perform httle useful work. A compuler requ:res software to be able to communicate and do useful
work. The fll’bl layer of soﬂware na cornputer system is the operating systfcm This is what starts, or
boots up, the machme helps in pulhng itself up by its own bootstraps and establishes a predctermmcd
.sel of conditions so that apphcal_lons can_ be run. When the computer is {urned-on or the reset button
is pressed, the control is phss to a set of control programs found in the ROM, a ﬁmiwérc store in
.compu.ler chips. These programs perform several tasks: (l) to check if hardware are functlonmg
correctly, (2) to load a set of control program from the dlsk to the memory, and (3) to pass confrol to
a routine which will accepl the user input. At this point, the operaling syslem is Ioaded and the user

can execute an application program such as MS-Word, Excel, Power Point, Access etc,

An operating system by itself has two levels of functionality. The first level is seen by the user
running the applications and utilizing system commands and utilities. At this lc'fcl, each operating |
system has its own set of command used to accomplish frequently performed tasks such as cbpying
files, renaming files, and formatling disks. Normally, frequently-used functions are included in the
operating system as system commands. The sccond is at the programming level, Al.t opéraliﬁg'

systems contain a sct of pre-packaged routine that performs the “primitive” functions necessary in



almost all applications. Such funclions, like sending a character to the sereen, reading and writing
information from a disk file, and accepling input from the keyboard are common to ncarly all

programs. ‘This level of functionality gives the programmer a set of standardized routings to perform
this task,

5. SOFTWARE

The operating systent alone renders the computer nearly useless, unless the user is capable of direetly
communicating to the hardware. In order to usc the computer system, soflware is necded Various
sofiware are available for different purpeses, such as MS-Word for word processing, Excel for

spreadsheet, Power Point for presentation, Access for database and Foxpro for database

programuming.

5.1.  MS-WINDOWS

MS-Windows is the most poﬁular operating system, it duplicates all the function performcd by DOS,
the defunct operating system of the seventies and eightié'sl. The capability of hlS-\Vindow 6pemling
system far excecds that DOS can offer it most convenient and easy 1o n.avigalc Most of the
commands are representcd by descnptwe figures called i icons. Nawgaimg around the wund(ms could
be 'mhncved through the usc of a pomhng dcvnce called mouse, normal]y in the desktop envtronmenl

the mousc pointer is seen as outline of an arrow or white arrow. To execute a command, Lhe user
only need (o bring the mouse pointer to the desired command described by the icon and press tha right
bution or doublc click the left button. Thc execution starts without typmg any s:ngle character in lhe
keyboard, unhkc the DOS convention that needs typmg a series of characlcrb comprnsmg the
command. In wmdows the compulcr screen 1s referred to as the deskmp When wo:kmg, the
application and documents must be in the wmdows The windows on the dcsklop must also be
arranged. I an application is left for a while, the wmdows are shrunk 1o an apphcauon icon, and still,

the appllcallon kccps running on the background. When an application is shrunk, the windows place

their application icon at the bottomn edge of the desktop until it is again restored to window size.

With windows, several powerful applications can be run simultancously. For example, switching
from a word pfoccssing application to a spreadsheet, and then to database application with a few

simple moves while quitting one application and restarting another, can ¢asily be done.

Pér!s of 2 Windows

liach application and some documents the user choose to work on, open as separate windows, Every

window has some common elements, however, not all windows use all the items.




i

The elements as illustrated below are the tools for working with the window and the application or

document within the window.,

Conlfof-menu Minimiza

v _‘ 'ﬂem HJEE:EJF I Maximize
| Efle  Edit Search  Help button
i - 24— Insertion
o poin!
I f‘qJ—Mouse
1 pointer
o Window
F border
i
i
- Vertical
=8 scroll bar
- . A
- Window corner Han‘zonlaf scrofl bar

The Control-menu box located in the upper-lefl comer of the wmdow is the most useful menu when
the use of a keyboard is preferrt.d The Control—menu commands can resize, move, maximize,

minimize and close wmdows, and switch to Task List.

The title bar shows the name of the application or document. If more than one window is open, the

title bar of the active window has a different color or intensity compared to the other title bars.

The window title, depending on the .type of ':window it appk:ars, can be the'name @f an application and

the name of the document, or a placeholder. In such case, “untitled” normally appears.

The menu bar lists the available menus. Most applications have a File menu, an Edit menu, and a

Help menu as well as other menus unique to the application,

The Scrotl bar can move the parts of the document into view when the cnlire document will not {it in
the window. With the bar, unseen portion of the lists and other information that is too long to fit in

the allotted space can also be viewed.

The Maximize and Minimize buttons cnlarge the aclive application window to fill the entire desktop or

shrink the window to an icon. Document windows enlarge jusi to fill the application workspace and



not the entire desktop. Afler enlarging the window, the Maxinnze button changes to a Restore button,

Restore button can be used to retorn the window to its previous size.

‘The Windew horder is the outside edge of a window, 1t can lengthen or shorten each side of the
border.

The Window corner can be used to shorten or lengthen two sides of a border at the same time.

The Workspace is where most of the work with an application are done. For example, the content of
the documents appears in the workspace when starling a wordprocessor. ence, an application can

allow the opening of more than one document window within this workspace.

The selection cursor shows where the user is in an individual docunient. It marks the place in the text
or graphics where the user begins typing or drawing. The arow-shape mouse pointer appears if you

have a mouse installed. Itis used to indicate items the user wants to select with mouse.
Starting Applications with the Run Command

The Run command is a handy way to start applications that you want (o rur only occasionally or have
not yet added {0 a group. You can open a document at the same time you' start the application.
Unless the program file is in your current path, you need to know the cxact directory location and

name of the program file before you can start the application.

l. Choose Run from the File mens in Program Managcr or I‘1le Manager
The Run dialog box appears.

2. Type the pathname and the exact ﬁlename of the program fite, mcludmg the extension
if there is one.

3. If you want the application to shrink to an icon as soon as it slarts makc sure the Run
Minimized check box contain an X.

4. Choose OK or press ENTER.

5.2, MS-EXCEL

Excel is a spreadshect typc of soﬁware package that operates under the MS-WINDOWS operalmg
system. The pnmary document in Excci is called a workbook. The workbook is similar to a ledger
that stores information and each workbook is made up of sheets. The sheet is virtually divided into
column and row; the column run horizontally and denoted by an alphabet sfarting with 4 and the row

run vertically and denoted by number starting from 1. The intersection of column and row is called

0)



cell. The ccll is the basic component of worksheet that accept different data types. The most
conunon data lypes are character, number, date, logical value and formaila,

Standard Toolbar

The standard toolbar that normally appears at the top of screen helps select aptions. Such options can
open workbodk, print and save worksheet, and ask for help. The follewing is a list of the individual

icons and their respective functions.

Excel’s Standard Toolbar

Button Name : Function

New Workbook Creates a new workbook

Opens a document

Save Saves the active workbook

Print Prints the active workbook

5 (@ @ [w S

Print Preview | Shows the active document in print preview mode
~/ Speller _ Checks the spelling of the document
,X) Cut Cuts the selection to the Clipboard
Copy. Copies the selection to the Clipboard
@ Paste Places the Clipboard contents at the insertion point




Button

Name

Function

&

Format Painter

Copies and pastes formalts for cells and objects

) . .
) tUndo Undoces the last action or command
s Repeat Repeals the last action or commiand,;
this is the same as the redo feature in Word 6
AutoSum Inserts the SUM function and shows sum range

Function Whzard

Starts the Function Wizard

Sort Ascending

Sosts selected rows in ascending order

Sort Descending

Soits selected rows in descending order

\&1] l”m‘: F/‘l lf_ﬂ fj;l |;~h| =

ChantWizard Activates the ChanWiza d
Text Box Inslerlts ff:xl Qr text box
Drawing Tums the d.rawling toolbar on ot ﬁff
Zoor.n'CDn'trot Set'.s the view of the document
Q Tip “l’izarld Tums the TipWizard toolbar on or off
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CoMweon | Name ] T Rwedtion ]
@ Help Displays Help
|Afiai Font Sel; I;e font fo; the selection
Font Size | ”;ets the font size for the selection
E Bold :loldfaces‘lhe selection
: Halic Italicizes the selection
E Underline Undetlines the se]ecli;: )
% | Align.Leﬂ" Eeft-atigns the selection ]
% Center Centers the selection -_
% Align Right R{ght.aligns the selection
@ gi?;:;;:c rosé anters the selection acrbss columns
E _ Curréﬁcy Siylg ' Ci.la'ngcs the selected cel:lsT to default cuﬁency style
" ,_::,' Percent Style Changes the selecied cells té de fau.lt percent style
z Comma Style Changes the selected cells to defaull comma .slylc




Bution

Function

+.0 I
.00

Increase Decimal

Adds one decimal place to the number format

_;f':g Decrease Decimal Removes one decimal place from the number format
:: L Borders Enables you (o select 2 border for the selection
1 |
% .4 Color Sets the color for the selection
.11. ¥ Font Color Sets the color for the selected font




Rasic Part of Excel Screen
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Tabs Worksheet

MS-Excel Basic Operation |

Following the description of the basic operation, the mousé is used as a poinling device instead of a
keyboard. The word efick means the user must press the left button of the mouse; dovble click means
Iwo successive clicks; and enter means thc user must prcss the Enter key in the keyboard Basic

operation dcalt only to the routine necessary to updatu the I’W4SP data base.
Creatihg a New Worksheet

When you enter Excel, it apens up to a new workbook, by default it contain 16 worksheets. You can
use¢ any of the worksheets. Even if there is an open workbook, ybu ?_:an still open another by moving

the mouse pointer in the New icon (upper lefl of the screen below the menu bar). Click on it.

Saving the Workbook

1. Move mouse pointer to File menu and click on it to bring the File menu option.
2. From the option available. Select Save.
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If the document your saving is new. The Save As dialog box appear. In the File Name box

type the name of the workbook.

Enter Pata in a Cell

: . : £
1. First sclect the cel! by moving the mouse pointer and clicking the right button. N
This routine place the insertion pomt in the active cell, which is hlghhgh!cd on-screcit with
border around it. .
2. Youcan start entering the data from your keyboard or numeric keypad.
3. To confirm the input, you can press ENTER or move the mouse pointer to the Formula bar
and click the Check icon. '
Editing Coll Contonts
1. Doublc olick the cell containing the data you want to edit. To edlt in the formula bar, click
in the formula bar. In case the formula bar is not dlsplayu:l choose Formula Bar from the
View menu located at the lop row of screen. '
2. Edit the cell contents. .
3. To confirm the modification made in the ccll chck the Check icon in the formula bar or
press ENTER. To cancel edits, click the X icon in the formula bar or press ESC.
Clearing Celis
1. Selectacellor range of cells that you want to clear,
2. From the Edit menu, choose Clear, and from the option available,
you the choose All, Contents, Formats, or Notes
Shortcut : Press DEL.
To clear cells by dragging é
1. Selectacell or range of cells that you want to clear.
2. Move the mouse pointer in the filf handle (lower right comer),
drag the fill handlc toward the area of cell or range, then the selected
arca will become gray.
3. Release the mouse button.
Copying Cells
1. Select lhe cells Lonlammg the dala you want 10 copy.
. From the Edit meny, choose Copy
3. Select the upper-left cell of the paste area.
Beware that any values or formula in the paste area mll be replaced
Undo Command
1. Tounde your last command, click the Undo button.
- From the Edit menu, choose Undo.
Creating Border around Celt
I. Choose the Cell menu from Format menu.
2. Choose the side you want put the border, and then choose type of border. Q

3. Click OK bution.
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Deleting Rows and Colomns

1. Sclect the row or columin .
To deleie morce than one row or column, extend the selection to inchude
all the rows or coluning you wand (o delete.

2. From the idit meny, choose delete (Intire rows or colunm)
3. Click OK baiton

Inserting Rows and Columns

I. Select the row or column
To insert more than one row or column, extend the selection to include
the aumber of rows or columns yon want to insert.

2. From ihe Edit menu, choose Insert (Entire rows or column)

3. Click GK button.

Selecting a Sheet or Sheets
To scleet a single sheet, click the sheet tab.
To select two or more sheets

1. Click the sheet tab for the first sheet you want to select.

2. If the sheets you want to select are adjacent, hold down the SHIFT key
and click the tab for the last sheet. :

I the sheets you want to select are non- ad]accnt hold down the CTRI key
and click the other sheet tabs.

Ungreup Selected Sheets

I. Move the mouse painter to the sheet tab. Click the left button of the mouse.
2. While the mause pointer still on the sheet tab, click the right buttan and
choose the Ungroup Sheets. :

Inserting Wnrksheel_

1. Select a sheet or sheels in the workbook.
2. From the Insert menu, choose Worksheet,
~ The new sheet or sheets will be inserted to the left of the sheet tab you select.
Shorteut : SHIFT+F11 :

Dc]efing \\.’orkshcet ‘

1. Select a sheet or sheets in the workbook. S _
2. Move the mouse pointer to the sheet (ab, and click the right bulton.
3. Choose Deleie, and click the OK bution. L

Moving Worksheel Within the Workbook

1. Select the sheet or sheets you want to move.

2. Drag the selected sheet tab along the row of tabs.
A black triangle indicates the place where the sheets will be inserted.
All selected sheets will be inserted. '

3. Release the mouse button.



Alternate Method

1. Sclect the sheet or sheels you want to move.
2. From the Edit menu, choose Move or Copy Sheet.

3. Inthe Before Sheet box, scleet where you want sheets to be inserted.
4. Click the OK button,

Moving Sheets to Other Workbook

Open the workbooks you want to move sheets o and from.
Sclect the sheet or sheets you want to move.

From the £dit menu, choose Move or Copy Sheet.

In the To Book box, sclect the destination workbook.

In the Before Sheet box sclect where you want the sheet or shccts mserlt‘d
Click OK button,

Snp W=

Alternative Method

p—

Open the workbooks you want to move sheets fo and fiom.

2. From Window menu, choose Arrange and choose horizontal.

In the desktop, two workbooks will open in screen split the workarea harizontally.
Select the sheet or sheets you want to move.

Hold-down the CTRL key and the right button of the mouse.

A paper icon and black triangle indicate that you made the move routine active.

5. Drag the mouse pointer to the other workbook and select where you want

the sheet or sheets inserted. ‘

6. Release the nouse button.

e

Copying sheets \\'ithinaw\'orkbook o Ce (

[. Select the sheet or. sheels you want 1o copy.
2. Hold down the CTRL key and miouse lefl button, and then drag the selected

sheet tab along the row of tabs. A black riangle indicates the place where
the copied sheet will be inserted.

3. Release the mouse button and then the key.

Alternative Mcthod

1. Selectthe shcct or shects you want to copy

2. From the edit menu, choose Move ar Copy Sheet. .
3. [In the Before Sheet box, select where you want the COp]E‘d sheet inserted.
4. Select the Create A Copy check box.

5. Click the CK buuon

Copy mg shects to other workbook

Open lhe workbook you want to copy {o and from.

Seleet the sheet or sheets you want to copy.

From the Edit menu, choose Move Or Copy Sheet.

In the To Book box, select the destination workbook.

In the Before Sheet box, select where you want the copicd shect inserled. '

Sclect the Create A Copy check box. ﬂ
Choose the OK Buiton. ' '
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Printing your Work

1. From File menu, choose Page Sctup to display the Page Setup dialog box.
2. On Page Sctup dialog box, their ave four option available

Page tab controls page orientation, sealing, page size, print quality, and
starling page number for the selected shect,

Margin tab controls page margins and the header and fooler margins, and
center the sheet on the page veilically, horizonlally or both.

Header/Footer tab controls page the headers and footers for the sclected sheet.
headers and footers are descriptive text that print at the top and bottom of
cvery page in your sheet, You can add, delete, edit, format, and position
headers and footers, and view them as they will print.

Sheet tab specifies which arcas of the sheet you want to print, and centrols
the print titles, page order, and draft quality. Also controls whether
gridlines, cell notes, and row and column heading print. The Sheet tab is
displayed if the active sheet is a worksheet or macro sheet.

3. On the Print What, their are three oplion avatlable.

Selection option prints only the selected cells in the selected sheets.
Nonadjacent sclections are printed on separate pages. Selecting this
overrides any print areas you have defined for the selected sheets using

- Print Arca option on the Sheet tab of the Page Setup diatog box.

Selected Sheets option prints the arca of each of the currently selected sheets,
with each print area starting on a diffcrent page. f no print area is defined
on a s¢parale sheet, the entire sheet is'printed.

Entire Workbook option prints the entire print area of all sheeb in the active

~ workbook. If a sheel does not have a print area, that entire sheet is printed.
4. On the Copies box specifies the number of ¢copies to print. '
5. On the Page Range, their are two option available.

Al option print all the pages in the selected sheets.

Page(s) option print the range of pages specified in the From and To boxes.
Page numbers you selected in the From and To boxes afTect which cells
will be printed, not the numbering of the pages upon which they are
printed. To change the numbering of printed pages, specify a number in
 the First Page Number box of the Page tab in the Page Setup dialog box.

6. The user have option to see the appearance of the prmt by clicking the
Print Preview button.

7. Printer Setup option give the user an ophon to select among the available
. priater drivers.

8. Click the OK butten to proceed printing.

53, ° MS-WORD

MS-Word is word processmg lype of software. This is analogous of convcr(mg your computer mlo
typewriter machine. You have page in which you type characters, you have a ruler lhal show whm,
you are as you type across the page. You have tabs stops and margin settings. The insertion point

moving across the page cven acts hike the print head moving across the page.

MS-Word offer more advance features that you need to create from simple to complex type of

document. When you slart Word you will notice almost the identical appearance with that of MS-



Excel. Most of the command are represented in terms of icon, in the middle of the workspace were

you enter your lext and other object included in your documents.

Starting Word

From the MS-Window cnvironment, y(.);u can double-click the MS-Wo'rd icon in the MS.-Office
program group. In some casc the MS-Office administrator is automatically loaded at start-up of
Windows cnvironment. Thé MS-Qfﬁcc administrator meénu icons are located in the upper right side
of the screen. You can start MS-Word by clicking the icon.

Quiting Word

—

Move mouse pointer to File menu and click. File sub-menu will appear. -

2. From the File sub-menu, move mouse pointer to Exit option and click.

The MS-Word environment will normally terminate. In some ‘cases, if some actlive
documents has not yet been save. MS-Word give the user’s option 1o save the documents,

Standard Toolbar

The standard toolbar whlch normally shown at the top of sereen helps you select the option, from
this toolbar. The user’s can open new document open existing document, print and save dt}cumem
and ask help to farther understand some funclion or proccdure to accomphsh desired task Usmg the

toolbar speed-up the desire task mslcacl of using the menu (located at the top of the screen) The
following shows thc list of standard loolbar icons and thelr functlon '

MS Weord Standard Toolbar

Dution Name "~ Function
D New Creates a new file based on the Nonnal template
@' Open - Displays the Open dialog box so that you can select an
‘ existing file to open
‘ EI Save Saves the current document
% Print Prints the current document
Print Preview Activates Word’s print preview features

e



Buiton

Copy

Initfates a spelting check

Cuis selected material to the Windows Clipboard

Copics selected material 1o the Clipboard

Paste

Pastes material fiom the Ciipboard'into your dacument

‘| Format Painter Copies the formatting of_ex selection to the text yon 5pecil'y
__E Undo Undoes the commands you select from the list presented
| A Red‘.3 Redo;:s (hc c":'nuna'nds fou select r§n1 !fxe ligl preseﬁtcd
ﬁ AutoFormal Formats your document automatically
Insert Auto Tlext ' Inserts an Auto Text t;ntry. N
Insert Té't.:;!e

Inserts a table into your document

-4}

Insert Excel

Inserts an Excel worksheet into your decument
Worksheet . '
==
= Columns Formats your document using columns
Q Drawing Opens the drawing application and enables you to drawa
picture in your docurnent
@ Insert Chart

Inserts a chart into your document
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Fins

Bul(en Name Function
S S I e
@E Zoom Control Scales your view of the document by the percentage you
Sl sclect ) 7
e ‘
&? Help Activales context-sensitive help

MS-Word Basic Operation

Opening and Existing Document

1. Click the Open Folder icon (normally second from the left) to bring up the open
dialog box.

2. In the Open Dialog box, select the file you to open from File Name combmauon :
box.

3 Click the OK buiton.

Changmg the Format of lhe Text

I. Chck the arrow but!on to the r;ght of the fom box to bnng the list of avallab1c font.

2. Scroll through the list box by chckmg on the scroll bar, and select a font by clicking
onit.

3. Begin typing. The text wnii appear in the font you just selected,

Changing the Font Size

1. Click the arrow button to the right of the fonf size box to bring the list of available size.
2. Scroli through the list box by cllckmg on the scroll bar, and select a size by chckmg on u
3. Begin type. The text will appear in the font size you size selectcd

Choose a Style

Perform any of the following procedures to change a font style:

Click en the button labeled B to set the bold feature on.

You also can press Ctri+B from the keyboard. '

Click on the button labeled 1 to set the iralic feature on.

You also can press Cirl+1 from the keyboard. :

Click on the button labeled U to set the underlined feature on.

You also can press Ctri+U from the keyboard.

Click on the button labeled B and I to set both bold and ifalic features
You also can press Ctri+B followed by Ctrl+ from the keyboard.

‘Settilig Special Effects

" Youcanusea variety' of special text effects:

Strikethrough
Superseript
Subscript
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* llidden
¢ Smallcaps
+ Allcaps

To sct any of these features, use the following procedure;

1. Open the Format menu and select the Font item.

2. If the Fonts tab is not on top, click on it.

3. In the Effecr group box, sclect the check box that represent the special effect
you want to tvm on.

4. Click the OK buiton,

5. Begin typing. Your text apbears with the special eftect you seleated.

Selting the Indentation

bl s e

Open the Format menu and seléct lhe Paragraph item.

If the Indents and spacing tab is not on top. click on il.

In the indentation group box, use the Left and Right spin boxes to set the indentation

from the lelt and righl margins, Click on the arrow buttons until the measurcment is correct,

or select the text’in the body by highlighting 1t w1lh the mouse and then type exact
measurement you want.

To set first line or hanging indentation’ opcn the Speclal drop-down list box by

clicking on its arrow, and sclect the appropriate item. Use the By spin box to sct the
nieasurement for the first line indentation or the hanging indentation,

Click the OK button. Your current paragraph takes on the indentation you ]w;t sel.

Each subsequent paragraph you create takes on this patiem, unless you reset the
indentation using the dialog box

Seumg Line Spacmg

[ (-,

Open the Format menu and selecl the Paragraph itém.

If the Indents and Spacmg (ab is not on top, click on it,

In the Spacing grouip box, use the Before and After spin boxes 0 set the distance in

pmnts from the previous paragraph and from the following paragraph Click ot the arrow
buttons until the measurement is correct, or select the text in the box by hrghhghtmg il with
the mouse and then type the exact measurement you want,

To set line spacing within the paragraph, open the Line Spacing drop-down hst box by
clicking on its arrow, and select the appropriate item. Then use the At spin box to set the

" measurement for number of lines or distance between lines, whichever is active.

Click the QK button. Your current paragraph takes on the line spacing you just set.
Each subsequent paragraph you create takes on this patiern, unless you reset lhe Ime spacing
using the dialog box.

Cop\mg and Inserting Text

e B

Highlight the text by dragging the mouse pointer over the text to be selected

Move pointer o Copy icon and click on it

Move mouse pointer to the place were you would like the insertion take plate

Move mouse pointer to Paste icon and click on it. Alternatively, you can press the right
button of the mouse to bring the menu option., select the paste by click on it.

Undoing and Redoing

If you do make a mistake, you can undo it by selecling the Unde option from the Edit meau.



This procedure undoes the last change you made to the document. Word always will add the name of
the operation you are about to undo as the sccond word of the Undo menu item. If you cannot undo

anything, this option change to Can't Undo and is dimmed.
Overstriking Text

There are times, however, when you want to type over existing text. To switch to this ediling mode,
press the Insert key in the keyboard. When you type, the characters you type replace any characters

to the Iefl of the insertion point. o tum off the overstiike mode, press the Inseri key again.
Deleting Text

Usc mouse pointer to highlight the desire text and préés the Del key from the keyboard.

Insert File

1. Move mouse pomter in thc locatlon were you would like the msemon take place
2. From the Insert menu, select File option,

3. From the File name combination box, select the file you would like to insert.
Click the OK button.

Creating the Header or Footer

1. From the View menu, choca Hcader and Tooter, ‘ ' g
2, The Header and Footer toolbar appear, click the switch bctwecn Hcadcr
and Footer button. The header and footer areas are enclosed by a nonprinting
dashed line.
3. Do one or more of the followmg,
Text - You ¢an type the text within the dashed line that surround the header or fooler area.
Page Number - Click the icon.
Current Date - Click the icon. °
Current Time - Click the icon.
4. To return to the document, choose the Close button on the Header and I‘ootcr toolbar or
double- chck the main text arca

Previcwing the Documcnl :

I. From ihe Flle menu, choose Print Prewew _ ‘
While in the print preview mode, you can perform the following options.

a) You can print lhe document by chck the Print button. .

b) You can switch the magmﬁer on and ofT by ¢licking on the magnifier button.

¢) You can switch to a one page view by clicking the One Page button.

d) You can switch to view multiple pages by clicking on the Multiple
Pages Bufton and dragging across the grid that appears, releasing the
mouse button when you have the multiple-page view you want to use.

e) You can zoom in or out on your document by adjusting the zoom
percentage in the Zoom Control drop-down list box.

1) You can switch the view of the ruler on and off by clicking on the
View Ruler button.

£) You can squecze a small amount of text on the final page into the
the outer pages by clicking on the Shrink to Fif button.




1) You can expand the preview screen to show only the page, the
toolbar, and the status bar ¢licking on the Full Screen button.
1) You can exit the preview maode by clicking on the Closc button.

Printing your Document

1. From the Fite menu, choose Print option.
A Pnint dialog box appear.

2. Inthe Print Whar drop-down list box. This option enables you to print the
document or several items ancillary to the document, such as Summary Info,
Annotation, Style, Autotext Entrics, and Key Assignmbnls.

3. Use the Copies box to enter the number of copies to print.

4. Use the Page Range oplion to determine how much of the document to print,
You can print All the document, the Current Page, or sclected Pages.

5. Check the Collate Copies check box to finish the first set of copy before
printing the sccond copy,

6. When all it set correctly, close all the dialog boxes you have open,
and click OK button, the printing process begin.

6. PW4SP DATA FILES

Pata files are collection of information rclcvérit tc; the preparétion of PW4SP. Data files are logically
group into three major arcas of mformallon The frst group oflnfmmatlon are the basc data that are
composed of information deriv cd from survey, ocular inspection, and existing information from the
provincial and national agenmes The second group of information are the kcy parameter data that are
composcd of information derived from’ applicable pohcucs assumptlon wafer test result, and cugrent
cost of commodily. The th:rd group of mfonnahon are the prescntahon of dala WhICh dcrn ed from
the prewously mentioned groups of information’s, this data are processed and then logically arranged
to show provincial prefile, cxnstmg facilities and sc!wce coverage, past financial perfomlance future

requirement of the relevant sector, cost estimates for future sector developmcnt and financial

arrangement.

6.1. Base lnformatlon ‘

1. Secio- economic Data (Socm -economic xls)

a) Mumc:palfCuy Status and No of Barangays ( Muncxly Status (P.1.1) )
b)  Past Population ( Past Population (P.1.2.1) & (P.1.2.2)} -

¢) Projected Populatlon ( Projected Population (P.1.3. ]) & (.1 3 2) )

d) Houschold { Household) (P.1.4))

€) Services ( Services (P.1.5))

f) Occupation { Occupation (P.1.6)) -

g} Family Income ( Family Income (P.1.7))

h} Expenditure ( Expenditure (P.1.8))

1) Education ( Education {P.1.9) )

2. Land Use Data (Landuse xls)
a) LExisting Land Use ( Existing Land Use (P.1.2.1) )



b) Future Land Use ( Futore Land Use (P.2.2))

3. Health Data (Health.xls)

a) Morbidity; Mortality and Infant Mortality { Morbidity and Mortality (P.3.1) )
b) Tacility ( Facility (P.3.2) )
¢) DPractitioner { Praciitioner (InN2.2) )

4, Water Reseurce Data (Water Sourcc x1s)

a) Gencral lnformahon ( Gen. ]nfo (P. 4. 1))
b} Water Source Information ( Source Info(P.4.2))

5. Water Supply Sysrems Data {Watcr Supply xls)

a) lLevell I‘amhly { Level | @5.1) _
b) Level1l System ( Level H (8.5.2.1) &(8.5.2.2) ) '
¢} Level HI System ( Level H1(S.5.3.1),(5.5.3.2),(8§.5.3.3) & (S. 5 3, 4))

6. Environmeatal Sanitation Data (Sanitation.xls)

a) llouschold Toilets { Household Toilets (P.6.1})

b) School & Student { School&Student (P.62))

¢} Schoot Toilet (Schoo! Tailet (P.6.3)) '
d) Public Toilet ( Public Toilet (P.6.4.1), (P.6.4.2) & (P 64.3))
¢) Drainage Facility ( Drainage Facility (P.6.5)) :

f) Solid Waste Collection and Disposal { {M) Solid Waste)

7. !m'eslme(it Data (Investiment.xls)

a)" Income & Expenditure (P.7.1)
b) PastIRA(P.7.2)
¢} Available Funds for Capital prend\lurc {P.7. 3)
d) Sector Previous Investment (P.7.4)
¢} Scclor Allocation in the AIP (P.7.5)
) Allocation of the 20% Dev. Fund (£.7.6)
g) Financial Indicator of WD {P.7.7)
h) Loan Status of WD (P.7.8) '
i) Affordability in Water & Samtalmn Serwces (P.7.9)

Key Paramete'r

1. Key Parmne{ero (Key Parameter xls)

“a) Key Parameter (Key Parameter)

b) Level [ - Safe and Unsafe (Level I Safe and Unsafe)
c) Well Source Composition {Well Source Composition)
d) Unit Cost {Unit Cost)

e) Scoring Factor {Scoring Factor)

) Annuat Investment (Annual Investment)

.~ Data Presentation

1. Provincial Profile (chapter-l.xls)



a} Outline of City and Municipalities (MTablz 3.1.1)
b) Current Land Use {(MTable 3.2.1)
¢} Drainage Arcas and Flow Rates of Major Rivers (M’i ‘able 3.2.2)
d) Distribulion of Households by Income Class (M¥igure 3.3.1)
e) Population Distribution by Occupation (Figure 3.3.2)
f} Population Distribution by Highest Attainment of Bducation (MFigure 3.3.3)
g) Provincial Outtine on Public Services (MTable 3.3. N
h) Public Facilitics and Scrvices by Municipatity (MTable 3.3.2)
1) Previous Population Development of the Province (MFigure 3.4.1)
j) Previous Population Development by Mummpahty {M Tab1e 34
k} Present Population Distribution (MFigure 3.4.2)
I} Outline of Urban and Rura} Areas in the Province (M Table 3.4.2)
m) [touschold Numbers and Houschold Sizes (MTable 3.4.3)
) Number and Rates of Ten L.cading Causes of Morbidity,
Mortality and Infant Mortality (MTable 3.5.1)
o) Reported Cases and Deaths of Notiftable Water Related Diseases (MTable 3.5.2)
p) Municipal Solid Waste Collection and D;Sposal and
Service Coverage in 1994 (MTable 3.6:1) -
q) Number and Ratio of Population to Health Facilitics
and/or Medical Practitioners (STable 3.5.1)
r) Types of Drainage Facilities (STable 3.6.1)
s) DENR Water Qualily Criteria/Water Usage and Classification
for Fresh Water (STable 3.6.2) '

2. Existing Facilities and Service Coverage (chapter-4.xls) -

a) Information on Existing Level 11 Systems (MT'ab‘le 4.1.2)
b) Infonnallon on Water District (MTable 4.1.3) . .
¢) Information on I‘\ustmg Level I{ Systems (MTabIe 4.1.4)
d) Infonmation on Fushng Level 1 Facilities (MTable 4.1.5) :
e) Water Supply Service Coverage by Municipality in 1994 (MTablc 41.7y
f) Water Supply Service Coverage by Municipality {(MFigure 4.1.1)

g) Sanifation Facilitics and Scrvice of Household T mlet:. Urban and

~ Rural, 1994 (MTable 4.2.1):
h) Provincial Service Coverage of Household Toﬂet Fa(:thllcs 1994 (MFigure 4.2.1}
1) School Toilet Facilities and Service Coverage in 1994 (MTable 4.2.2)
j) Public Toilet Facilitics and Séivice Coverage in 1994 (MTable 4.2.3)
k) Details on Existing Level 11f Systems (STable 4.1.1 Sheet 1 to 4)
1) Details on Existing che] It System (STable 4.1.2 Shcet 110 6)
m) Number of Leve! 1 Facilitics by Safe and Unsafe Classification (STable 4.1 A4y

n) Estimation of Unserved Population by Municipality (STable 4.1.5)
0) Estimation of Population Covered by Safe and Unsafe Source ‘

by Municipality (STable 4.1.6 Sheet 1 to 2)
p} Sanitation Facilities and Service Coverage of Houschold Toilets
by Type, by Municipalily, Urban and Rural, 1994 (STablec 4.2.1)

3) Past Financial Performance in Water Supply and Sanitation (chapter-6.xls)

a) Acfual Income and Expenditures, (MTable 6.2.1)

b) Intemal Revenue Allotment to the Province (MTable 6.2.2)

c)} Allotted Funds for Capital Expenditures {20% DF) (MTable 6.2.3}

d) Actual Amount of Sector lm’estmcm to the Province by Concerned Agencics
(MTable 6.3.1)

¢) Annual Investment Plan 1995-1999 (MTable 6 3.2)

f) Sector Allocation in the Annual Investment Plan (MTable 6.3.3)



g)  Allecation of the 20% Development Fund (MTable 6.3.4)

h) Financial Indicators of Provmcralﬂ\dumc;ml Waterworks in the
Province (MTablc6.4,1). o

i) Loan Status of ProvuwmlMumcxpﬂ Wa!elworks (MTablc 64.7)

J)  Afferdability in Water Supply and Sanitation Serv:ccs (Mlable 6 6 1)

k) Income and Bxpenditure (STable 6.2.1)

1) PastInternal Revenue Altolment for Ihc Province (STable 6.2.2)

4) Water Source Dexe.’o;:menr (chaptcr-? xls)

a}E x1stmg Groundwater Soun,es in thc Provmcc (MTablc 7.1. l)
b) Work Flow of Groundwater Avaitability Map (SFigure 7.3.1)

¢} Existing Spring Sources by Municipality (STable 7.4.1} -

d) River Information and Related Data (STable 7.5.1)

¢) Water Quality Analysis Results (STable 7.5.2)

f) Existing Well Soucces {STable 7.6.1) ‘ o
g) Standard Specification of Wells by Mumcupahly (S1 able 7. 6 2)

5) Future Requirement in Water Supply and Samrahon Environment (chapter—s xls)

1) Provincial Sector Targets (MTabIe 8.2.1) L
2) Base Year Service Coverage of Water Supply (MTablc 8.2 2)
3) Base Year Service Coverage of Household Toilets {(MTable 8.2.3)
4) Basc Year Service Coverage of Public School Tmlcts and
Public Toilets (MTable 8.2.4) ' '
5) Base Year Service Covcrage of Munmpal Sohd Waste System in 1994
(MTable 8.2.5) .
6) chmnal Population Project (MTable 83.1) -
7) Municipal/City Poputation Projection (MTabIe 83.2) _ :
8) Municipal/City Population for the Year 2010 & Grawth Rates (MTable 8 3 3) -
9) Past and Projected Populanon by Current Municipality/City (MTable 8.3.4)
10) Past and Projected Populauon by Urban and Rural Area of Current
Municipality/City (MTable 8.3.5) .
1 1) Projected Public School Enrollment and Number of Public Uhhty
by Municipality (MTable 8.3.6)
12) Population to be Served by Target Year (Water Supply) (MTable 8.5. l)
13) Additional Number of Households to be Served by Target Year
(Household Toﬂets) (MTabIe 8.5.2)
14) Additional Number of Public School Student to be Served by
Target Year (Schoo! Tmlets) (MTable 8.5.3) .
15) Additional Number of Public Utilitics with Sanitary Toilets
by Target Year (MTable 8.5.4)
16) Population to be Served by Urban Sewcragc in Phase I (MTable 8.5. S)
17) Additional Number of Urban Households to be Served by
- Municipal Solid Waste Syslem in Phase I (MTable 8.5.6)
18) Water Supply Facilities Required by Target Year {MTablc 8.6.1)
19) Sanitation Facilities Required by Target Year (MTable 8.6.2)
20) Number of Garbage Collection Trucks Required in Phase [ (MTable 8.6.3)
21) Estimation of Base Year Service Coverage of Water Supply (STable 8.2.1)
22) Population Coverage in Phase I Provided by Served Population
in the Base Year (STable 8.2.2)
23) Number of Houscholds Served by Sanitary Tmlets in the
Base Year (1994){(STable 8.2.3)
24) Number of Public School Student Served by School Toilets in the



Base Year {(§Table §.2.4)
25) Number of Public Utilitics with Sanitary Toilets in the
Basc Year (1994) (STable 8.25) -
26) Houscholds Coverage in Phase 1 Provided by Pxisting l‘ﬁcdmcs in the
Base Year (Houschold Tojlets) (STable 8.2.6)
27) Public School and Public Coverage in Phasc | Provided by
Existing l‘ac1ll_tncs in the Base Year (STtable 8.2.7) .
28) Census Population and rojected Population {STable 8.3.3)
29} Municipal/Cily Population Projection (STable 8.3.4) :
30} Municipal/City Population for the Year 2010 and Estimate
Growth Rates (STable 8.3.5)
31) Past and Projected Popu!auon by Current Mummpahtyl(l:ty (STable 8.3.6)
32) Past Population Development by Urban and Rural Avea (STable 8.3.7)
33) Poputation Projected by Urban and Rural Avea (STable 8.3.8)
34) Past and Projected Popua!allon by Urban and Rural Area of C‘urrcnt
Mumc:pahly/Cuy (STable 8.3 9) 2
35) Projected School Enrolinient by Mumc;pahly by Iargct Year (S’] ‘able 8.3.6)
16) Projected Number of Public Utilities by Municipality by ‘Target Year (STablc 8.3.7)
37) Population to be Served by Level 11 System in Phase 1 (STable 8.5.1)
38) Population to be Served in Phase I (Water Supply) (STable 8.5.2)
19) Population te be Scrved in Phase I (Water Supply) (STable 8.5.3)
40) Additional Number of Households to be Served in
Phase I (Household Toileis) (ST; able 8.5.4)
41) Additional Number of Households to be Served in
Phase 11 (Household Tmlets) (STable 8.5.5)
42) Additional Number of Public School Students to be Serv ed in
Phase I and 11 {Schoo! Toilcts) (STable 8.5.6)
43) Additional Number of Public Utilities with Sam!aty Toxleis in
Phase I and I (STable 8.5.7) . .
44) Urban Watcr Supply Facilities chu:red by Target Year (’STable 8 6. l)
45) Plan for Expansion of Existing Level Il Systeni (";Table 8.62) :
46) Rura] Water Supply Facilitics Requlred by Target Year (STable 8. 6 3)(a)
47) Rural Water Supply Facilities Required by Target Year (STable 8.6.3)(b)
48) Urban Household Toilets Required by Target Year (STable 8.6.4)
49) Rural Household Toilet Required by Target Year (STable 8.6.5)
50} Public School Toilets Required by Target Year (STable 8.6.6)
51) Public Toilets Required by Target Year (STable 8.6.7)

6) Cost _Esn'ma!es Jor Ftru.tre Sector Development {chaph:r-l[’.ﬂs}

a) Price of Major Materials by Facilities (MTable 10.2.1)
~ b) Construction Cost of Water Supply Facilities Required for

Phase 1 (2003} (MTable 10.3.1) . ‘

¢) Breakdown of Community Dcvelopment and Training Cost (MTablc 10.4. l )

d) Unit Cost of Level I (Gravel Packed Decp Well — 40m Depth) (STable 10.2.2a)

e) Unit Cost of Level 1 (Natural Gravel Packed Deep Well-40m Depth)(STable
10.2.2.b)

f) Unit Cost of Level } (Gravel Packed Deep Well — 80m Depth) (STable 10.2.3. a)

g) Unit Cost of Level | (Natural Gravel Packed Deep Well-80m Depth)(STable
10.2.3b) - ‘

h) Unit Cost of Level 1 (Gravel Packed Deep Well - 120 Depth) (STable 10.24)

i} Unit Cost of Level I(Natural Gravel Packed Deep Well-120in Depth){STable
10.2.4.b)

j} Unit Cost of Level | (Deep Well Rehabilitation ) (STable 10.2.5)



k) Unit Cost of Level 1 (Shalow Well - 18m Depth) (STable 10.2.6)

) Unit Costof Level I (Spring Development) (STable 10.2.7)

m) Unit Cost of Level 11 (600 Service Population) (STable 10.2.8)

n) Unit Cost of Level 1L (5,000 Service Population) (STable 10.2.9)

o) Unit Costof chcl NI (10,000 Service Population) (STable 102, 10}

p) Unit Cost of Level 111 {15,000 Service Population) STable 10.2.11)

q) Unit Cost of Flush Water Scaled with Septic Tank Toilet (STabie 10.2.12)
r)  Unit Cost of Pour Flush with Double Pit Latrine (STable 10.2.13)

s) Unit Canstruction Cot of Ventilated Improvc Pit Latrine (STable 10.2.14)
1) Unit Construction Cost of Pit Latring (STable 10.2. 15)

u) Unit Cost of School Toilet (STable 10.2.16)

v) Unit Cost of Public Toilet (STable 10.2.17)

w) Cost of New Laboratory (STable 10.2.18)

1)} Cost of Upgrading Laboratory (STable 10.2.19) ~ - . ;

y) Construction Cost of Water Supply Facilities Required for Phase 1 (STabIe 10.3.2)
z) Cost of Sanitation Facililies Required for Phase I (STable 10.3.3)

aa) Cost of Sanitation Facilitics Required for Phase 11 (STable 10.3.4)

1) Financial Arrangemen.!s (chap-1 l.lxls)

a) Projected Interal Revenue Allotment for Medium-’l‘cnn
Sector Development (MTable 11.2,1) - .
b) Pro;cctcd Allotment of IRA to the Relevanl Seutor by ‘
Component, 1996-2000 (MTable 11.2.2) - L
¢) Financing Reqmrcmcnls by Scctor Componenl for the Provmcc {MTable 1 I i
d) Additional Fund Requirement for Medium-Term Plan (MTable 11.3. - g »
¢) Internal Reveniue Allotment for Water Supply and Sanitation Sector :
by Municipalily (Medium-Term Dcvclopment 1996-2000) (MTable 11.3. 3)
f) Relationship between Fundmg Levels and Percent of Coverage
for Water Supply Sector (MFigure 11.4.1)
£) Relationship between Funding Levels and Percent of Coverage
for Sanitation Sector (MFigure 11.4.2) ' '
h) Municipal Investment Need Ranking for Urban Water Supply (MTable 11.4.1)
i) Distribution of Provincial IRA to Mumcipahty for
Utban Water Supply (MTable 11.4.2)
j) Municipal Investment Need Rankmg (MTab!e l 1.4. 3)
k) Percentages for Annual Investment (STable 11.3. 1) '
1} Comprehensive Investmem Need Ranking of the Municipalities (STable 11 4 1)
m) New Cost Sharing Arrangement Between NG and LGUs (MTable 11.5.1)
n) GOP-Assisted Level I Water Supply and Sznitation Project Cost (MTable 11.5.2)
o) Cost Sharing for the Project 9Case 1): 1997 Price Level (MTable 11.5.3)
p) Cost Sharing for the Project {Case 2): (MTable 11,5.4)
q) Available IRA for GOP-Assisted Level I Water Supply and Sanitation Project for
Eligible Municipalities (STable 11.5.1)
r} Available IRA for GOP-Assisted Urban Sanilation Project for Eligible
- Municipalities (STable 11.5.2)
's) Total Available IRA for GOP-Assisted Level I Water Supply and Samtahon
Project (STable 11.5.3}
1) Investment Program of GOP-Assisted Level 1 Water Supply and Samtahon
Project (STable 11.6.1) a
u) O&M Cost for Level 1 Facilities (STable 11.6.2)

v) O&M Cost per HH/Month by Facility and Proportion to Monthly Family
' Income (STable §1.6.3)



w) Family Income '(STablc 11.6.4)
x) O&M Cost for Rural Sanitation (STable 11.6.5)
¥) O&M Cost for Urban Sanitation (STable 11.6.6)

7, DATA FILES LINKAGES

Linkages are logical connection between records in the data files. Through linkages, once the user's
updates the source data, all data in the slrcams of]iﬁkages are dynamically updated. Linkages are the
convenient tools of updating related da{a, these also shiéld the user’s from ﬂi.c complexity of formula
manipulation. Wiih the aid of the data linkages the uscr’s can concentrale more in validating the

source data.

The following table lists the 10gica| conncctions for each worksheet.
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